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— Barbara Blowes

From  the President
SeniorNet Mac Inc. PO Box 475

Christchurch 8140
41 Essex Street, Christchurch

Web: http://seniormac.org.nz/

Pop in and have a cuppa in 
the learning centre. You 

can get answers to computer 
problems, ask questions and get 
advice. If you need to bring in 
your computer please ring:

03 365 1979 
and leave a message

Items that can be solved quickly 
will be $5 but problems requiring 
significant time will attract up to 
$20 workshop charge.

The SeniorNet Mac Apple NEWS 
is distributed bimonthly on 10th 
April, June, August, October, 
December and February. You 
will be kept updated on important 
matters  with a Mini Newsletter 
by email every week, in between 
times.

Morning Sessions
MONDAY, WEDNESDAY, 
THURSDAY and FRIDAY 

10.00 am to 12 Noon

SeniorNet Mac, Christchurch Executive and Committee

John Hampton Patron

Committee Members for 2019/20 are:
Barbara Blowes President president@seniormac.org.nz 
Charlie Millar  Vice President  vice.president@seniormac.org.nz
Elizabeth Chesney Secretary secretary@seniormac.org.nz
Elizabeth Chesney Treasurer  treasurer@seniormac.org.nz
Derek Brown Trustee
Brian Henderson Fundraiser funds@seniormac.org.nz
Erika White Events Manager events@seniormac.org.nz
Barbara Robinson Customer Services services@seniormac.org.nz
Christene Berry Member
Robin Harrington Bookings bookings@seniormac.org.nz

Ross Beach  Editor editor@seniormac.org.nz

At last Winter is all but over and we are now into 
daylight saving. This is the time of the year I enjoy 

most, being able to get outside and into my garden.
I have just updated my iPad to iOS 13, gosh I do 
wish they wouldn’t keep changing things.You get 
so used to the old things so its a learning curve to 
find what they have altered. Mail has a lot of new 
features and instead of the reply button at the top 
its now at the bottom and a lot of new features as well. Oh well, I suppose 
it does make us learn new things all the time. Safari is also very interesting 
as you can now have multiple pages open at once—good if you want to 
compare prices. Enjoy the new update— you can now put more Apps on the 
Home pages—great for me as I have so much stuff! 
Next month Catalina will be coming out for the Mac. I may not update my 
Photoshop as it may not work in Catalina. I will have to find out as I think my 
version is a 32 bit programme and it won't be compatible with the update, 
just a nuisance as I use photoshop such a lot and I am not renting the 
programme monthly as this is a waste of money for my use.   �

The recall does not effect any other 15-inch 
MacBook units.
Check which model you have, choose About 
This Mac from the Apple menu in the upper-left 

corner of your screen.  If you have a MacBook Pro (Retina, 15-inch, Mid 
2015), enter your computer’s serial number on the program pages to see 
if it is eligible for a battery replacement.
If in doubt, check with your nearest Apple Service Agency: 
Service Plus at Unit 3b/1 Pilgrim Place, Christchurch.

IMPORTANT NOTICE

NEWS FLASH 

Our Rooms will now be opening 
on

Thursday Mornings 10 - 12 noon

commencing 3rd October
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Deadline for December/January Apple NEWS

November 28th
Please have your copy for the next Apple NEWS to me 
by the above date.
Copy can be either typed straight into an email, as a 
Word file or as Rich Text Format.
Digital images need to be at least 220dpi  or higher 
(72dpi will not reproduce well)
Please no hard returns except at the end of a 
paragraph.

Hi there.
It must be spring—our weeping 
cherry is in full bloom, there is 
blossom everywhere, daylight 
saving is here, the "Brave 
Blossoms" shocked Ireland in the 
Rugby World Cup, the All Blacks 
have had 2 wins, Australia is 
moaning again  they reckon they 
are being picked on again—and 

it's all the "Ref's" fault, the world is still in turmoil, they 
are still arguing over Brexit, Climate change, and wether 
to "Impeach him"—but Christmas and New Year will be 
here in under 4 months and they will still be arguing over 
the same things. This issue of Apple News marks my 3rd 
Anniversary as Editor. We have the usual contributors—
Pam Doughty, Brian "the Pirate", plus Part Two of my 
article on Typefaces, this issues's "Profile", "Cookin' with 
Apple", plus warnings of a 
couple of problems with Apple 
devices. Members Photo Corner 
features four images from my 
overseas travels. A late "News 
Flash" the rooms at 41 Essex 
will now be open on Thursday 
Mornings 10-12 noon.     � 

Welcome to New Members

EditorialContents

Antonio Yuge and Bruce Levey
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No liability is accepted for any errors or omissions or inadvertent disclosure not meant for publication. Any opinions 
expressed may not necessarily reflect the views of the Editor or SeniorNet Mac Inc. who, likewise, neither endorse nor 
accept responsibility for products or services of any advertisers or for opinions expressed within the Apple NEWS.

Every effort has been made to ensure that no known copyright issues have been breached and 
that appropriate acknowledgements have been made, with regard to all articles and advice 
given in this publication.

Disclaimer

 Cookin’ withAPPLE USER GROUP              

Canterbury Apple Users 
is a subgroup of Christchurch SeniorNet Mac Inc. and 

meets on the last Wednesday of each month at 
7.30 - 9.30pm in the SeniorNet Mac Rooms, 

41 Essex Street, Christchurch.  
A heated room with all conveniences, tea/coffee and bikkies. 

FREE to SNM members. General public $4.00
Meetings will disscuss user's problems and review 
recent announcements and news relating to Apple 
products. All welcome   �

Our Sponsors

Also in association with:
The Federation of NZ SeniorNet Societies

Community Organised 
Grants Scheme

WANTED

• Web Advertising on our Web Site
• Apple NEWS Advertising
• Reasonable Rates: For prices contact:

Customer Services
03 365 1979

services@seniormac.org.nz

Advertisers Our Direct banking number is 020816-0376043-00

PLEASE when paying monies to SeniorNet Mac, 
include as reference either your Name 

or Membership Card number.
We are receiving credits from time to time from 
unknown members.
We have no way of telling who they are from.
Your Membership card has a unique number and 
should begin with the figure 4

Elizabeth Chesney
Treasurer@seniormac.org.nz

IMPORTANT

INTERNET  BANKING

    BANBURY APPLE PIE
350 grams shortcrust  pastry.

680 grams cooking apples, peeled, cored & sliced.
Juice of ½ a lemon. 114 grams sultanas.

14 grams candied peel (optional).
85 grams soft brown sugar.

pinch of ground cinnamon. pinch of ground 
nutmeg.

rind and juice of ½ an orange
Set oven to 205°c roll out the pastry on a lightly 
floured surface and use to line a buttered, shallow 
850mil pie dish, reserve the remainder for the lid 
(top). Sprinkle the apples with lemon juice and 
fill the pie with layers of apple, sultanas, peel, 
sugar and spices. Sprinkle the orange rind and 
juice over and cover with the remaining pastry, 
trimming the edges neatly and pressing together 
firmly. Make a small "steam hole" in the centre 
of the lid and decorate with the pastry trimmings. 
Brush with a little milk or beaten egg to glaze 
and cook for 30 minutes or until golden brown. 
Sprinkle the top with a little sifted icing sugar. 
Serve hot or cold, accompanied by custard or 
cream. Serves 4 to 6.    �

—Favourite Cotswold Recipes, compiled by Dorothy Baldock
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In Part One I discussed the basic typefaces, in Part 
Two I will tell you what my favourite typefaces are 
and why. Starting with Sans Serif, as most of my 
early work was in the days before Digital printing the  
3 Sans Serif faces that I was most familiar with and 
worked with were:

Gill Sans was a popular typeface in the '50s and 
'60s, designed by Eric Gill and is very similar to 
the signage used on the London Tube Stations. 
Univers is my favourite—if I was to say that on 
the Internet howls of rage and indignation would 
sound around the world—as the universal San Serif 
favourite is Helvetica. As I was using Univers in my 
work prior to the digital era (Helvetica at that time 
was not available for use in New Zealand), and to 
me personally when you compare those two faces 
Univers is much sharper and clearer than Helvetica:

Of Course there are dozens of other Sans Serif faces 
available in digital format. Arial was adopted by 
Microsoft (for the masses) and spread throughout 
the world on PC's using Microsoft software and 
applications and is generally considered to be a poor 
substitute for Helvetica. Sans Serif faces such as 
Avant Garde Gothic, Futura, Franklin Gothic, Frutiger 
and Spartan are all available in digital versions. 
I use Univers as a text face in Apple News (47 Light 
Condensed) as it is easy to read over a short measure 
in column width, and being a condensed face allows 
more words to a line.
The Serif faces, that  were available before the 
digital era, that I was familiar and worked with were:

Helvetica • Baskerville • Univers • Bodoni • Arial • Times 
 Tekton • Brush Script • Goudy • Chopin Script • Garamond 
Snell Roundhand • Zapf Chancery • Mona Lisa • Rockwell 

 Caslon  Park Lane • Perpetua • Zebrawood  Gill • Mistral
Fette Fraktur• Thorne Shaded

Bernhard • Lithos Pro • PLAYBILL • Stencil• Penhurst
Goudy Text •Baskerville • Reisling •Marker Felt • rialto

Typefaces

All those faces became favourites of mine. With the coming 
of Digital faces many more became available:

All these Serif faces are more suitable for use as book 
typefaces—some more so than others. As I moved into 
Desktop Publishing designing and preparing books for 
publishing, I became aware of all the numerous typefaces 
available and began using Bembo, Baskerville, Garamond 
Caslon, Perpetua (designed also by Eric Gill—who received 
notoriety in recent years for a rather unsavoury life style in 
the 1920s) and Goudy.
I think the face that became my most favourite is Centaur, it 
is a marvelous face to work with in book design, with all its 
various fonts—Roman, Italic, Bold, Bold Italic, Roman with 
small caps and old style figures, Italic with old style figures, 
Bold with old style figures, Bold Italic with old style figures and 
Swash Capitals. For an example of my use of this face, look 
at a copy of The Summer Ships by Colin Amodeo, published 
by The Caxton Press in a Delux hand numbered limited edition 
and in a Paperback edition, the Delux edition won a Gold 
medal in the Pride in Print awards for the year 2000. 
So those are my favourite typefaces, in Part Three I will 
discuss the numerous display typefaces and how they 
can be used to show the different eras—Art Deco, Art 
Nouveau, Gothic and Medieval. Also the Caligraphic and 
Display faces.    �    

Part Two

Gill Sans, Univers, Grotesque

Univers, Helvetica

Caslon, Baskerville, Perpetua,
Plantin, Goudy, Times Roman,

Bodoni

Centaur, Minion, Garamond, 
Joanna, Bembo, Fenice, 

Clearface, Palatino,
Souvenir

“When a type design is good it is not because 
each individual letter of the alphabet is perfect 
in form, but because there is a feeling of harmony 
and unbroken rhythm that runs through the 
whole design, each letter kin to every other and 
to all.”
~ Frederick Goudy, designer of the Goudy Typeface

—from tell us about type, mr goudy.
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Photo CornerMembers

1

2

3 4

1 Weeding the Lawn—Japanese style.
 Kenrokuen Gardens, Kanazawa, 2007.

2 Roman Ruins, Dougga, Tunisia, 2008.
 The ruins date from around 250 AD.

3 Horses and Cabs stand in the rain.
 Piazza de Spagna (to the left of the   

Spanish Steps), Rome 2008.

4 Lunch time for the horses (an    
extremely hot day), Piazza della   
Repubblica, Firenze (Florence), 2008

Photos from the 
Editor's Travels
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Profile

Chris started with ‘Sinclair Computers’ as their Technical 
Officer repairing computers. This came to an end, as many 
people never picked up their repaired items they had 
expected him to fix.
He has many varied interests and, as an avid railway 
enthusiast, he has been on two very interesting train trips 
in Australia: the Ghan from Adelaide to Darwin and the 
Indian Pacific 68 hour journey from Sydney to Perth.

Chris Wright

‘The Canterbury Mineral and Lapidary Club’ has also been 
one of his interests, with particular fascination in fossils 
and minerals. His knowledge of all the pebbles found at 
Birdlings Flat is vast.
Radios have been a lifelong interest, as he was a 
broadcasting technician for ten years, before everything 
was moved to Auckland.
Chris has had a varied interest in computers, joining many 
groups and finally ending up at AUGC, now a branch of 
SeniorNet Mac.
He helps SeniorNet Mac at the Drop-In sessions with his 
broad knowledge on the computers and he is always very 
helpful. With a sense of humor, his love of riddles he is 
entertaining to many.     �

1+P L U S  O N E

In the June/July Apple News I mentioned in the 
article Spams Scams and Unwanted Phone calls how 
even with an unlisted phone number, that we were 
getting the odd scam phone call. I received the follow-
ing interpretation from SeniorNet Mac member Chris 
Wright.—Editor
Here is my interpretation of how a scammer dials an 
unlisted phone number
1. They start with a number say—1234567890
2. They dial that number
3. If they get a good response from it they take note of 
it so they can use it again or sell it at the “Market”.
4. If however they get a bad response from it they 
then will add 1 to it like so—1234567891
5. They will then repeat steps 2, 3, 4 until they run 
out of numbers or time, unbeknown to you the next 
number that comes up is your unlisted number and of 
course you answer it
1234567892
1234567893
1234567894
1234567895
1234567896
1234567897.........
I call this method “Plus 1” because they keep incre-
menting the number by 1.
I have caller ID on my phone so when a callers number 
comes up and I do not recognise it, especially if it 
starts with a 0000 I pick up the phone but I DO NOT 
say anything & a few seconds later the phone goes 
“Beep...Beep”.     �

I USED TO THINK I WAS 
INDECISIVE, BUT NOW I'M 

NOT TOO SURE.

IF "PLAN A"
DIDN'T WORK. THE

ALPHABET HAS
25 MORE LETTERS!
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If you are fed up with the annoying 
scams that we are getting then you
need to read The Little Black Book of 
Scams.
It's very informative and covers things 
you may not even realise are scams.

 In this digital world you have to be 
extra careful or you could loose a lot 
of money by not being very savvy.

Copies are available from
 president@seniormac.org.nz
 they are also available at the
 SeniorNet Mac Rooms
 41 Essex Street Christchurch

2019 Photographic Competition
 SeniorNet Mac

3 Categories
Portrait  6  Street Scene  6  Landscape

All entries to be 5 megapixels
Entries Close: November 13 2019
All entries and enquiries to:
president@seniormac.org.nz
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Tech Tip Tips from Pam Doughty
courtesy AUSOM News, 2019

5

Paste without keeping format-
ting—macOS
When you copy text from some applications—particularly from 
the Internet—the copy process includes its formatting, such as 
the text size, colour and font choice.
When you then paste this into some text fields it looks out 
of place. This can make your email message hard to read 
or may cause images and text of your carefully formatted 
newsletter to fly off the page.
To paste the text without its original formatting (so it formats 
in the same way as the area you are pasting into), instead of 
pressing Command+V, press Option+Shift+Command+V. 
Microsoft Word, FirstClass Mac software and some other apps 
have a “Paste Special…” or “Paste and Match Style” menu 
option to do the same thing.    �

Share your Wi-Fi with a friend 
—iOS
iOS has a handy feature that allows you to share your Wi-Fi 
password with a friend visiting your home.
You both need to be using iOS11 or later and you and your 
friend need to have each other listed in the Contacts app.
Your friend needs to open the Settings app, tap Wi-Fi and 
select the name of your Wi-Fi network from the list. Your 
device needs to be connected to your Wi-Fi network.
When your friend selects your network you will see a 
message on your iPhone or iPad asking you if you want to 
share your password. When you tap “Share Password” 
your Wi-Fi password is sent to your friend’s iPhone and 
they’re able to join your Wi-Fi network. Your friend will 
have access to your Wi-Fi. Although your friend will not 
actually know your password immediately — if it is stored 
in Keychain — it may be viewable on their Mac.     �

Emoji in Mail
At the last iWork SIG one of my tips was to use 
Control+Command+SpaceBar to easily select an emoji.
With macOS Mojave and Mail 12 (I tried it with Mail
12.4), you can access emojis.
With just the click of the mouse, or the tap of a finger, you 
can embed an emoji in your Mail message, and convey a bit 
of emotion that may be hard to put into words, but easy to 
display in a graphical shortcut.
To add an emoji, I opened a new message and typed a few

words so that my cursor is within the body of the email, 
where I would like the emoji to appear.
The toolbar includes a new icon near the top right — that
looks like a smiley face.
To obtain the screenshot above I clicked the smiley face 
and a character viewer palette appeared showing the
available emojis and symbols I could include in the email.
I found I could click the emoji I wanted and it appeared
where my cursor was located.
I selected the emoji and pressed Command-+ a few times 
to make it a little larger.
Note: The method I used at the iWork SIG still applies to 
Mail and Mojave, but using the smiley icon in Mojave
might mean adding emojis is easier.    �

Quick Tip: Stationery Pad — 
macOS
Why use Stationery pad
This ‘tip’ has saved me from over-writing valuable files 
for many years — even before apps came with ‘Tem-
plates’.
When I first started using a Mac I found that I was
frequently opening a file I had created, editing it and then 
using Save As… to create my new file. This process was 
almost as dangerous as playing with fire. In those days 
there was no keyboard shortcut for Save As... AND the 
option was beneath Save when accessing the File menu.
I think I probably accidentally over-wrote three or four
valuable ‘original files’ before I thought “there had to 
be a better way”.
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I am sure AUSOM members are all saying. Easy solu-
tion: copy the original file in Finder before you start.
Yes, I agree however there remains an additional step 
that could be taken to protect the original file. It will 
mean that the original file can be ‘double-clicked’ and 
rather than opening the original file the application 
that created it will open a copy.
(The file name with modern versions of MacOS will prob-
ably have the word COPY added to the end of the original 
file name and it will be saved in the original folder.)
Protect the original file by using Stationery Pad.
This works with most file types, I tried with those 
created with Microsoft Office, iWork (Pages/Numbers/
Keynote), Photoshop and Text Editors.

How to use Stationery pad
Select the file you want to protect
Press Command-I or File >Get Info to view the file info.
Check the box marked Stationery Pad

Close the info window.
When this file is double-clicked, Finder automatically
creates a copy and opens it leaving the original safe 
from change.    �

View your Calendar as a List — 
macOS
If you would like to see your Calendar as a List there is 
a very simple way to do it.
Just type “” (yes 2 double-quotes) into the Search Field).
You can scroll through the list that appears.
I could not find an easy way to Print the above list. 
However, you can use the standard Print options for 
your Calendar.

The trick here is to select LIST (circled at the top of the 
next image).
Then adjust the start date, end date (circled above) 
and click Continue (lower right).
I printed my Calendar as a PDF so I could show you 
part of the output, at the end of this article    �
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GUEST 
SPEAKERS

29 October   

Kelsea Nelson-Cummins                                 
SPCA Community Engagement and Fundraising Co-Ordinator 

“SPCA Engagement in the Community/ Information"
Kelsea Nelson-Cummins has been working at the SPCA for 4+ years and 
absolutely loves it. She is an Animal lover who is very passionate about her job 
and anticipates meeting everyone to share stories about the amazing work the 
SPCA does in the community.

Based in Christchurch, Stacey has spent the last 10+ years with a DSLR in her hands.
From landscapes, wildlife, macro, flowers, still life, photo artistry and now food, her 
experience encompasses a wide range of photography genres.
Currently she is specialising in food photography. But what does it take to properly style a 
scene? What props do you need? What are the essential styling tricks? Natural vs Strobe 
lighting? Creating images with a WOW factor, offering professional photography, print 
sales and image licencing services.

26 November Christmas Social
Morning Speaker: Grant Sidaway, 
 Executive Officer, SeniorNet Federation of NZ, Wellington.

 "What's the Point"
Topics include:
•  Reasons for older people to keep learning new things 
• How the internet is being used today 
•   Wearable technology 
•  Smart Speakers 
• Arrival of 5G networks

Afternoon Speaker: Stacey Hill, 
 Evoke Artisan Photography / NPSNZ Vice President

 “The Art of Food Photography”



Page 12Helping Seniors with Apple Technology  http://seniormac.org.nz

SeniorNet Mac  Social &
Luncheons

1. Barry Clark
2. Alison Fox

3. Derek Brown
4. Andrew Grant

Raffle Results 
24 September

Raffle Results 
27 August

1st. Carole Benson

2nd Christene Berry

3rd Elizabeth  Chesney

Dr Geoffrey Rice

Dr Geoffrey Rice 

Pictorial Overview of Lyttelton’s history up to about 1990.

27 August

Thank you to Dr Geoffrey Rice for the very nostalgic visual 
journey into the English colonisation of Lyttelton and 
Christchurch specifically from 1840,s.
The early development in photography has enabled us to see 
the dramatic highlights and changes that occurred over that 
time. 
For all of us it was a very nostalgic reminder of the the journeys 
our forebears endured and the roles they played in their time.
Now, we have that opportunity to add new life history whilst 
enjoying the Lyttelton and Christchurch lifestyle.   �

We had a very informative Social with various members of the committee talking about our 
SeniorNet Society. The committee all felt it was a good idea that members knew what was 
going on. Elizabeth Chesney discussed the finances and showed statements on the screen to an 
appreciative audience. Membership was also discussed—we do need more members and what 
we can do to achieve this. A short movie was screened about Cyber Attacks, it was prepared by 
the National SeniorNet and was very good. Questions were asked from the floor and it was good 
to be able to answer them.
Joe Adams discussed how to digitise videos, he is willing to teach this to our members.Brian 
Henderson taught us how to cram music into our devices. 
The afternoon was very well received and the feed back was pleasing and helpful.   �

24 September

Warning: iOS 13 Updates
The following article was posted by Newshub on 24 September, 2019

Apple is in the process of amending the issue. 
Apple users are being urged to hold off on updating their 
phones after a recent update left them vulnerable to hackers.
Fast Company reported about the “nasty location privacy 
bug” on Friday, saying iOS 13 isn’t “respecting” location 
privacy settings for some apps.
The security flaw meant phones were open to malicious 

Photo credit: Getty

activity, with the potential for hackers to obtain access to 
contact details, reports Forbes.
Apple is in the process of amending the issue - with the 
release of iOS 13.1 due to come out on Tuesday (US time).
Writing for Forbes, cybersecurity journalist Kate O’Flaherty 
says the bug was affecting apps such as Facebook.
“It does not impact all apps in iOS 13,” she says.
“If you haven’t upgraded to iOS 13 yet, it’s probably better to 
wait - when this and a number of other fixes will be applied.”
Last month, Forbes reported about a “critical security flaw” 
in iOS 12.4, saying some iPhones, iPads and iPod touches 
were vulnerable following the update. Apple was forced to 
urgently release a patch.     �

Recent iOS update makes devices vulnerable to hackers, 
Apple confirms.   —Mark Quinlivan—Reddit

�        �         �         �         �
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iPhone 11 / iPhone 11 Pro—Just the right amount of everything.

Apple Watch Series 5
 Introducing Series 5. New Always-On Retina display. Pair any case with any band in 

the Apple Watch Studio.

Just Released
New f rom Apple

All-new dual-camera system. 6.1-inch Liquid Retina HD display.1 The fastest chip in a 
smartphone. All-day battery life.2 Water-resistant to 2 metres for up to 30 minutes.

iPhone 11 iPhone 11 Pro
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The new iPad
A larger 10.2 inch Retina displays

support for the  full-size Smart keyboard and the new iPad OS.

Just Released
New f rom Apple
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—Editing and a Whole Lot More
—Brad Smith  courtesy of AUSOM, April, 2019

"

Version 4.0 for Mac OS High Sierra (Minimum for 
these notes)

Launch Photos, go to Camera Roll/Photos
Let’s look at the uppermost menu bar items from L to R.

The usual Mac traffic lights. Close (RED) — Minimise
(Orange) — Expand (Green)
The backwards arrow takes you back one window.
The slider makes your image icons larger or smaller.
The middle area controls how you display photos — i.e.
grouped by Moments, Collections or Years.
Info (circle with an i in it) shows the Metadata for that
image.
Share (square with arrow) gives alternatives to send the
image/s.
Heart button allows you to make the selected image a
favourite.
Rotate button will do just what it says.
Search Box lets you search on different criteria.
Near the Top Right of the Window: ‘Showing’ is a drop
down menu (We’ll call it Filters)

NOTE: The Keywords will appear once you have set them
for an image. Use the Keyword Manager

FILTERS
Go to All Photos then Keyword Manager or Command-K
Try dragging down to Favourites. This will show you all
the Favourites in your Library.
Try all the different criteria in the Filter (Showing) menu.
Now we’ll create our own.
• Open Keyword Manager.
• Type 2 stars
• Type 3 stars
• Type 4 stars
Notice that the shortcuts automatically fill. This means
that you can select the image and then type 2. It will
automatically be given 2 stars.
You can then allocate a rating for each image.

FILTERS — Using a combination of filters…
I want to find a 3 star image that is also a Favourite. So
I’ll go to my Photos Library and in the Filter Menu, tick
Favourites and 3 stars. This will bring up the 4 images
that address those criteria. This means that you can search
on all sorts of criteria. Note you can have multiple ticks.

Once you populate your library with all your images, Photos 
will automatically ‘sort and filter’ in the background. No, 
it won’t find ‘bible’ because it’s so defined, but it will find 
Books. Over time it will find all images that have things like 
Sky, Water, People, Mountains, Sea, Flowers and Houses 
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etc. You’ll be surprised how many categories it will quickly 
‘filter’ for you.
When I typed ‘Flowers’ into the search field in my
Library, Photos found 4,604 photos that it had catalogued
automatically.

DUPLICATING YOUR IMAGES.
I won’t explain in detail, but most of you know that I like 
to work on ‘duplicated’ images so that I always have the 
original to look back on.
Right-click and choose ‘Duplicate 1 Photo’ from the 
dropdown menu.

EDITING YOUR IMAGES.

Choose an image from your library. Double-click to make it 
full size. Click on Edit this will bring on the Editing tools.

Let’s not forget that we can use the ‘Auto Enhance’ 
tool (next to the Edit/Done button to tell Photos to do its 
enhanced version of the image, automatically. You don’t 
have to do anything.

WE’RE NOW GOING TO EDIT AN IMAGE
First of all, go up to the View menu and drag down to
Show Histogram. This will add the Histogram to the top
of the Edit menu.

Light Menu note 
tiny arrow to the 
left of Options

The ‘Light’ menu gives you a number of sliders to adjust 
your Image. Brilliance, Exposure, Highlights and Shadows 
are just some. Try adjusting your image and if you don’t 
like the changes, you can always press the tiny ‘back’ 
arrow, which will remove those edits from this palette. By 
the same token, you can click on the little Auto button and 
let Photos do the work. It will do its best to enhance your 
image. You don’t like it? Click on that ‘Back’ button again.

The Colour Menu allows you to enhance the colours in
your image and balance the Contrast.
If you would like to see your image dramatically
transformed, then have a look at the Black & White
menu. Try the Auto button for a clever change of image.

The Retouch tool will let you ‘spot clean’ your image.

Adjust the size of your brush to just a little bigger than the 
mark on your image, then click. It will fill the spot with the 
pixels around it, thus cleaning up the image.
Red Eye does just what it says. 
Try the Auto button. Fairly clever stuff. Or undo and try the 
brush for yourself.

Advanced Editing Tools
Now that we’ve looked at the basics of Editing, let’s go a
little deeper.
To view your Histogram go to the View Menu and about
mid way down you’ll find Show Histogram. You can also
make it disappear, the same way.

Histogram When you click on your image and look at the
Histogram, you will see the Red, Green and Blue channels
plus the neutral Grey. We can adjust some of the extreme
gamma in Channels.
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Levels is a very powerful tool. I use it a lot. Here we’re
looking at the RGB panel, which shows a fairly even graph. 
It is possible to change from RGB to Luminance.

Like Levels, Curves can also be a very powerful tool. Try 
the different views to see what changes you make. Then try 
the Auto tool again. If you’re not happy, click on the ‘Back’ 
arrow again.
Try the following using a photo that has a red tinge to see
how Levels can help us. We’ll choose Red and have a look
at the 5 adjusters and the difference they make. Take care
that you don’t go too far.

White Balance gives us the ability to adjust the tonal
balance of Neutral Grey, Skin Tone or Temperature/Tints.
This is a very powerful tool, best used to adjust skin tones,
whilst making sure you know how to use the Back arrow.

Selective Colour is fairly new to Photos, but once again
is a great tool. If you have an image with strong colour 
contrast, you can choose and adjust individual colours. The 
dropper tool becomes important here.
Definition and Sharpening
We use Sharpen if we’d like to see the pixels in our image,
crisper or sharper. Edges is the threshold for neighbouring
pixels and Falloff tends to increase the effect. Sharpening
is not really ‘sharpening’, it’s just increasing the contrast
where pixels meet other pixels.

Definition is harsher than Sharpen so it’s probably best to
use Auto in both tools first.
Noise Reduction is great for reducing grain or noise in
large areas. e.g. Sky

Vignette
I worry that vignette attracts the viewer’s attention more
than the actual image. Of course you can use Vignette to
draw the viewer’s attention to the right area and keeps the
viewer from being distracted by edge annoyances.
If you muck up all your tools, click this button and every
tool will go back to its original position.

*If you have a Live Photo, you can turn that off by 
clicking on the ‘live’ icon in the bottom left corner, 
when the photo is full size and in Edit mode. Live 
photos are difficult to edit, because they’re actually 
small movies.

Photos works hand-in-hand with other applications
Whilst Photos is great at what it does, it doesn’t do 
everything. And why would it? Developers have to leave
something for someone else’s income. Thankfully, Photos
welcomes us to use other Editors on our computers, to find 
the tools that it doesn’t have. Like Layers, or Cloning.

Photos can’t Clone, but it does allow you to open the 
image in Elements, Photoshop or any of your other graphics 
programs to achieve your desired end results.

Using External Editors within Photos
Basically, there are TWO ways. Firstly by using the
‘Editing Extensions’.
• Open the image you want to edit in Photos.
• Click on the Edit button, top right.
• Now click on the Extensions button.
• Note all the Applications that you have available to you
for Advanced editing of your image.
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• If you can’t see the Application you’re looking for, click
on ‘Open In…’. This will give you a choice of all the Apps 
suitable on your computer.
• Choose your App, make your changes and SAVE.
You may have to save TWICE, depending on your 
application. Close the image and check within Photos 
to see if the changes have been saved. It can be a little 
‘buggy’.
The second way is by using the ‘Edit With’ command.
To make changes to your image beyond Photos is to
simply SELECT your image in the icon view within
Photos
• Go to the Image menu
• Mouse down to Edit With and select
• Choose the Application you want to use in that list.
• Make your edits, SAVE, then close the image and check
that it has been saved in PHOTOS.
Once again, it can be tricky so ALWAYS WORK ON A
DUPLICATE, and ALWAYS SAVE, SAVE, SAVE!

Yes, Photos is great at Editing and the more you practice, 
the more you’ll see how well it works. It CAN’T do 
everything a full scale editor can do, but hand in hand with 
a compatible application, you’ll love it.
A couple of links: Apple Info on Using Editors
https://apple.co/2QpnDBu
and
YouTube video https://youtu.be/YPxgJE-dOyk    �

Do I really need that new Mac
—George Engel courtesy AUSOM August 2019
So… I’m getting older, along with my dear Lady Arlene. Arthritis is setting in and the aches 
are starting. Arlene’s foot looks like it lost a fight with a bat-wielding snake and both knees 
lost a knife fight with a Dwarf. So she uses a cane when we walk and sometimes a walker. 
Our Apple iMacs are about the same. Two of them are 2008 models and my main iMac is a 
2010 Model. I’m using Arlene’s iPhone 6 and she has an iPhone 8. I’m still running OS X El 
Capitan and don’t want to update any more as I still have some 32-bit $$$ software on it. 
Decision time?

?
Food for Thought...Food for Thought...Food for Thought...Food for Thought...Food for Thought...Food for Thought...

Maybe I’m not alone. Some of you may be in the same boat. I still use my older Adobe software, like Photoshop CS6, InDesign 
CS6, etc. as I refuse to go for their subscription monthly model; besides, it works fine for my purposes. So, no need there. Pages, 
Keynote and the rest all work fine and share with my iPads so I can start writing on one and finish on the other.
Now, on the Mac/iMac vs iPad issue I now face, how often am I using my iMac now? I find myself using and carrying the 
iPad wherever I go now, along with my iPhone and Apple Watch. My iMac is only turned on maybe two or three times a 
week, if that! Wherever I sit, I have the iPad and iPhone nearby. Why get up to turn on the iMac? iOS devices are lighter, 
smaller, more portable, more accessible for travel, and less expensive than Macs/iMacs. In some cases, just as powerful. 
For $300-$500 I can get an iPad Air to do almost everything my iMac does; from Cameras, photos, Keynote, Writing, 
sharing, leisure entertainment, email and Internet. Darn, I can even use my Apple Watch to receive a phone call now. Heck, 
I can even turn on/off the individual lights inside the house from my iPad/iPhone and watch my Security Video Cameras 
while sitting in my recliner. So why a new Mac? Hmmm…
Even if my iMac’s Hard Drive has a catastrophic failure,I have another bootable Hard Drive SuperDuper copy available to 
swap into it at a moments notice. Worse case, I have another old 2008 used iMac ready to swap out the whole thing with 
a current backup ready. All my iOS devices are iCloud backed up daily, so I can’t lose anything there either. So why was I 
thinking of spending $1,300 U.S. for another iMac?
I guess I AM getting old! Sometimes that older Apple equipment that you have is just like us. Maybe a bit slower at turning 
on; not able to use the latest stuff; but still able to use, maybe with a replaceable part or two. But, we still have serviceable 
life left in us. So, maybe I’ll use that $1,300 to take Arlene out for a fine dinner, to enjoy what's left in our life, and maybe 
some vitamin supplements or two with an after dinner massage. Yeah, that’ll work! Maybe…    � 
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 Courses &Workshops

WORKSHOP DESCRIPTIONS

November
COURSE DESCRIPTIONS

For all of the above Courses, Workshops, Contact: bookings@seniormac.org.nz

or Phone 03 3651979 and leave a message. We will contact you as soon as possible.

We prefer that members with iPad and iPhones take an iPad/iPhone introductory workshop before taking any other course relative to 
their device. Please contact the teacher if you are confident that you have sufficient basic knowledge to move to the next level.                    

2 Week Courses: $20
Workshops: $10
One on One $20 per session

 Please pay at the start of your Course or Workshop. 
All Courses and Workshops held at the SeniorNet Mac Rooms, 41 Essex Street, Christchurch 

COURSES

iPad/iPhone Basic  2 weeks 5th Nov. 12th Nov. Tuesday 10 -12 noon

iPhone applications 2 weeks 14th Nov. 21st Nov. Thursday 10 -12 noon

iPad /iPhone Basic Basic operations for iPhone and iPad.
iPhone applications How to use the key Apple provided application on your iPhone

iCloud and Dropbox. What are these and how to use them.
iPad/ iPhone Introduction. Basic introduction to iPad / iPhone 
Simple Print. Basic turning photos into a book.
Applications Highlights. For apps, keynote, numbers, pages, files.
Upgrading to Catalina. Issues and gotchas re upgrade of the latest Mac OS
Skype/FaceTime. Basic video—conferencing applications
Word processing on Mac and iPad The various options and their features

WORKSHOPS

iCloud and Dropbox. Thursday 7th Nov. 2 - 4 pm

iPad/ iPhone Introduction Monday 11th Nov. 2 - 4 pm

Simple Prints. Tuesday 12th Nov. 2 - 4 pm    

Application Highlights. Wednesday 13th Nov. 2 - 4 pm

Upgrading to Catalina. Monday 18th Nov. 2 - 4 pm

Skype/FaceTime. Monday 25th Nov. 2 - 4 pm

Word processing on Mac/ iPad. Thursday 28th Nov. 2 - 4 pm
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 Adverts 
from the past that would be banned today
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Brian the Pirate’s Tips

Tip #1
HOW2 Type Common Symbols & Special Characters 
in Mac OS X
Keyboard Combinations for Common Special Characters
Here are the most common symbols and their corresponding key combination.
NB - OPTION + 2 simply means hold down the Option key and the number 2 key.

Currency Symbols
• € (Euro sign): OPTION + 2
• ¢ (Cent sign): OPTION + 4
• ¥ (Yen sign): OPTION + y

Copyright and Trademark Symbols
• ® (registered trademark): OPTION + r
• © (copyright): OPTION + g
• ™ (trademark): OPTION + shift + 2

Mathematical Symbols
• ÷ (division): OPTION + ?
• ≤ (less than or equal to): OPTION + <
• ≥ (greater than or equal to): OPTION + >
• ^ (circumflex): OPTION + i
• √ (square root): OPTION + v
• ≠ (not equal to): OPTION + =
• ≈ (almost equal to): OPTION + x
• ± (plus-minus): OPTION + shift + =
• ∞ (infinity): OPTION + 5
• ø (empty set): OPTION + o
• ∑ (N-ary summation or Sigma): OPTION + w
• ƒ (function): OPTION + f
• ∫ (integral): OPTION + b
• ∂ (partial differential): OPTION + d

Punctuation and Quote Marks
• “ (left double quotation mark): OPTION + [
• ” (right double quotation mark): OPTION + SHIFT + [
• ‘ (left single quotation mark): OPTION + ]
• ’ (right single quotation mark): OPTION + SHIFT + ]
• „ (double low-9 quotation mark): OPTION + SHIFT + w
• ¿ (inverted question mark): OPTION + SHIFT + ?
• • (bullet): OPTION + 8

Miscellaneous
•  (Apple symbol): OPTION + SHIFT + k
• # (number sign): OPTION + 3 Continued on next page
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Brian the Pirate’s Tips

Continued on next page

The Keyboard Viewer
Besides the symbols above, more can be typed using a regular Apple keyboard.
Mac OS has a built-in utility called the Keyboard Viewer – and on-screen keyboard 
displaying many possible symbols.

To Activate the Keyboard Viewer:
1. Open System Preferences -> Keyboard
2. Tick the box labelled Show Keyboard and Character Viewers in menu bar

The Input menu now appears in the menu bar as shown (5th icon on the right - X)

The Input menu now appears in the menu bar as shown (5th icon on the right - X):
X

3. Click on the Input menu icon. From the drop-down menu options choose Show Keyboard Viewer to open the utility

The Keyboard Viewer shows key combinations mentioned 
above, and many more. It can also be used to insert symbols— 
simply click on a symbol to insert into documents or emails.
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SeniorNet Mac Inc. Rooms and Learning Centre
41 Essex Street, Christchurch

Brian the Pirate’s Tips

Hold down the OPTION key, or OPTION + SHIFT to see the choices available. 
The Keyboard Viewer always remains on top of other windows, and even stays in position when you switch to another 
workspace in fullscreen mode.

The Character Viewer
Just like the Keyboard Viewer, the Character Viewer can be accessed via the top menu bar when the Input menu has 
been enabled. Choose Show Character Viewer from the drop-down menu, to open Character Viewer as shown below. 
It can also be accessed within applications such as Safari and Pages by choosing Special Characters from the Edit 
menu (or COMMAND + OPTION + t).

�
There are thousands of symbols within the Character Viewer, grouped into useful categories such as Math Symbols, 
Punctuation, Arrows and Latin. Simply double-click on any item to insert into the current document.


